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LightCycler® 480 Instrument Quick Guide
Protein Melting
Protein Melting Analysis Principle: 
Protein Melting is monitored using hydrophobic binding dyes, like SYPRO® Orange,  and is used to determine 
the stability of protein in a given condition.  The stability is determined by the Tm of the protein melting.

The change in Tm from a reference condition to the test condition can infer a change in stability.  Often the 
test condition is used to assess different buffer conditions, or the interaction of the protein of choice with 
compounds, ligands, or other proteins in the test condition.  

Different solutions may have an effect on this stability, increasing or decreasing the determined protein Tm.  
Interaction of the protein of choice with another molecule or protein could have a stabilizing effect, increasing 
the Tm of the protein of choice proportional to the concentration of the ligand and the binding affinity of 
the ligand (Matulis et al, (2005) Biochemistry 44, 5258-5266; Vedadi et al, (2006) PNAS, In Press; “Amazing 
LightCycler® 480 System Applications: High-Throughput Screening of Buffers for Optimal Protein Stability”, 
Bertram H.A. Ong and Ralf Jauch, direct communication to Roche).

	
Run Protein Melting
Detector Setup:

1.		  In the LightCycler® 480 software, enter the tools menu by clicking .
2.		  Click to select the Detection Formats from the bottom of the list on the left.
3.		  Click  to create another detection format.  Name the Detection Format intuitively using the 	
		  name of the dye to be used (e.g., “SYPRO® Orange”).
4.		  From the LightCycler® 480 System I and System II  settings examples below, program the appropriate 	
		  detection format.

  Notes: 	The examples shown are for SYPRO® Orange.  If you choose to use another dye such as SYPRO® Red, 	
			   please use the appropriate wavelengths for excitation and detection (emission) for your dye of choice.

			   A Light Cycler System II states the name on the front of the instrument covering.  A System I will only 	
			   State LightCycler® 480.  The wavelengths are not the same between the systems. Use the wavelengths 	
			   which agree with the LightCycler® 480 instrument you are using.
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Protein Melting

System I Format System II Format

Run Protein Melting, continued

a.		  Choose the appropriate wavelength for Excitation and Emission by clicking the corresponding checkbox.
b.		  Click the name field and change the name to the dye of choice.
c.		  Click the Melt Factor field to enter the melt factor of 1.
d.		 Click the Quant Factor field to change the Quant Factor to 10.  This should have no effect on melting 	
		  assays.
e.		  Click the Max Integration Time field to set it to 1 second.
f.		  Click .
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											            Protein Melting

Melting Program Setup
This Run Protocol is used for all future analyses, but may be modified anytime.  Program the Protein Melting 
to have the following settings, as shown in the picture below:

	 Note: 	 The Ramp Rates of 4.8 and 2.5 are the default for the 384 MWP setup.  If you are using the 96 MWP 	
			   setup, the expected default/maximum Ramp Rates are 4.4 and 2.2, and should not be changed. 

1.		  Change the Detection Format to the newly created SYPRO® Orange format.
2.		  The Block Size is determined at start-up by the LightCycler® 480 according to what block is in the 		
		  instrument.  This cannot be changed unless the instrument is powered OFF and the block is changed. 	
		  The LightCycler® 480 detects which block is present when performing its Self-Test after being powered 	
		  ON.
3.		  Set the reaction volume to the desired volume.
	    a.	 For the 96 well plate/block, a volume of 15 or 20 mL is suggested.  A minimum of 10 may be used, 	
			   but may not yield optimal results.
	    b.	 For the 384 well plate/block, a volume of 5 to 15 mL is suggested.  A volume less than 5 mL may be 	
			   attempted, but may not yield optimal results.  The minimum instrument setting is 3 mL.
		  c.	 A single Program is typically used, and the program is renamed to Protein Melting or another name 	
			   for user clarity. 
			    •	 This program should have the Analysis Mode of Melting Curves.	
		  d.	 Program three temperature targets as follows:
			    •   	 The first target is 20°C, with a Hold of 15 seconds.  All other fields are left at the default.
			    •   	 The second target is typically 85°C, with an Acquisition Mode of Continuous, and 10 		
			         	 acquisitions per degree C.  All other fields are left at the default.

		      •   	 The third target is 20°C, with a Hold of 15 seconds.  All other fields are left at the default.
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Protein Melting

Melting Program Setup, continued
	 Notes: 	 If it is determined by the researcher that this temperature is not acceptable, this temperature should 	
			   be changed.  The maximum temperature which can be programmed into the LightCycler® 480 is 99°C.

			   No hold time is necessary to see an effect at this maximum temperature.

			   The ramp rate is determined by the number of acquisitions per degree and the exposure time 		
			   of the detection system.  This cannot be edited, except by increasing or decreasing the number of 		
			   Acquisitions per degree C.  

4.		  Save the Run Program as a “Run Template” by clicking the down arrow next to Apply Template, then 
		  select Save As Template.  
5.		  Give this template an intuitive name which includes intention of the run, the detection format, and the 	
		  size of the block.  
6.		  Save the template into your desired folder to be applied to New Experiments in the future.

Readiness Program Setup
1.		  This Run Protocol is used to “ready” the LightCycler® 480 instrument for all future plate runs.  		
		  Program the LC480 Readiness Run to have the following settings, as shown in the picture below:
					   

	 Note: 	 The LC480 Readiness Run only needs to be used when the instrument has been idle for more than 	
			   10 minutes.  The LightCycler 480® lamp will have powered off to save lamp hours.  This run activates 	
			   the lamp so successive runs do not have a warm-up period of waiting after loading the plate and 		

		       	 pressing  .  

			   The intention of this run is to prevent the 105°C heated lid from having an effect on the user’s protein 	
			   melting analysis plate.  Although this is a preventative measure, no effect was seen from not 		
			   performing this LC480 Readiness Run.
	
			   The Ramp Rates of 4.8 and 2.5 are the default for the 384 MWP setup.  If you are using the 96 MWP 	
			   setup, the expected default/maximum Ramp Rates are 4.4 and 2.2, and should not be changed.  
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											            Protein Melting

Readiness Program Setup
	    a.	 Change the Detection Format to the newly created SYPRO® Orange format.  This is done for 		
			   consistency, although any detection format works for this run.
	    b.	 The Block Size is determined by the LightCycler® 480 instrument according to which block is in 		
			   the instrument. This cannot be changed, unless the instrument is powered OFF and the block 		
			   is changed. The LightCycler® 480 instrument detects what block is present when performing its Self-	
			   Test after being powered ON.
		  c.	 Set the reaction volume to the desired volume.  This is done for consistency, although any reaction 	
			   volume works for this run.
			    •	 For the 96 well plate/block, a volume of 15 or 20 mL is suggested.  A minimum of 10 may be 	
				    used, but may not yield optimal results.
			    •	 For the 384 well plate/block, a volume of 5 to 15 mL is suggested.  A volume less than 5 mL may 	
				    be attempted, but may not yield optimal results.  The minimum instrument setting is 3 mL.
			    •	 A single Program is typically used, and the program is renamed to LC480 Readiness Run or 	
				    another name for user clarity. 	
				    This program should have the Analysis Mode of Melting Curves.
		  d.	 Program one temperature targets as follows:
			    •	 The first target is 20°C, with a Hold of 15 seconds.  All other fields are left at the default.
									       

 	 2.	 Save the Run Program as a “Run Template” by clicking the down arrow next to Apply Template, then 
		  select Save As Template.  
	 3.	 Give this template an intuitive name which includes intention of the run, the detection format, and 	
		  the size of the block.  
	 4. 	 Save the template into your desired folder to be applied to New Experiments in the future.
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Protein Melting Experimental Conditions Setup and Determination
Determination of optimal Protein and Dye concentrations:

	 Note: 	 The protein and dye concentrations may need to be optimized for each protein.  Protein size and 		
			   hydrophobic domain content impact the association with the dye, and thus the total fluorescence 		
			   obtained in the analysis.  Typical protein concentrations range from 0.5 µM to 10 µM.  Typical 		
			   SYPRO® Orange dye concentrations range from 5x to 20x, although some may find lower 		
			   concentrations useful.  Typical Reaction sizes range from 5 µl in a 384 well plate to 20 mL in a 96 well 	
			   plate.

1.		  Prepare the protein in to a 20 µM stock in a suitable screening buffer.  Other dilutions can be made for 	
		  the ease of pipetting.
		  a.	 Suggested buffers if another is unavailable:
			    •	 50 mM Hepes, 150 mM NaCl, 5 mM MgCl2, 2 mM DTT, pH 7.4.
			    •	 Phosphate Buffered Saline (PBS)
			    •	 Standard HEPES screening buffer (100 mM HEPES, 150 mM NaCl, pH 7.5), Vedadi et.al.
			 
		  Note:  It is not necessary to use these buffers;  however, it is suggested to avoid buffers containing BSA, 		
			       DMSO, or other compounds that may cause high background or effect the stability of the protein as 	
			       this hinders the assay.  Many compounds used with the protein are dissolved in DMSO.  In small 		
			       amounts this may not harm the assay, but a vehicle control should be used to ensure the effects on 	
			       Tm seen are due to the compound of interest.

2.		  Prepare a 100x working stock solution from SYPRO® Orange 5000x Stock in the buffer of choice from 	
		  1.1.  Further dilutions can be made for ease of pipetting if desired.
3.		  Combine into wells described in Table 1 to determine the optimal concentrations using a standard 		
	    10 mL reaction size.  Adjust appropriately if another final volume is used.  The final concentrations are 	
		  shown in Table 2.

Protein Melting
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Protein Melting Experimental Conditions Setup and Determination, continued
		

Table 1 
Protein from 
100 µM Stock 

SYPRO® 
Dye from 

100x 
Stock Buffer

Well A1 4.0 mL 0.5 µL 5.50 µL

A2 4.0 mL 0.67 µL 5.33 µL
A3 4.0 mL 1.0 µL 5.00 µL
A4 4.0 mL 2.0 µL 4.00 µL
B1 2.0 mL 0.5 µL 7.50 µL

B2 2.0 mL 0.67 µL 7.33 µL

B3 2.0 mL 1.0 µL 7.00 µL

B4 2.0 mL 2.0 µL 6.00 µL

C1 1.0 mL 0.5 µL 8.50 µL

C2 1.0 mL 0.67 µL 8.33 µL

C3 1.0 mL 1.0 µL 8.00 µL

C4 1.0 mL 2.0 µL 7.00 µL

D1 0.5 mL 0.5 µl 9.00 µL

D2 0.5 mL 0.67 µl 8.83 µL

D3 0.5 mL 1.0 µL 8.50 µL
D4 0.5 µL 2.0 µL 7.50 µL
E1 0.25 µL 0.5 µL 9.25 µL

E2 0.25 µL 0.67 µL 9.08 µL
E3 0.25 µL 1.0 µL 8.75 µL
E4 0.25 µL 2.0 µL 7.75 µL

	 Table 1: This table is an example of the concentration matrix for optimization.  					   
			   The actual concentrations, amounts, rows and columns may be chosen by the user.

											            Protein Melting
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Protein Melting Experimental Conditions Setup and Determination, continued
		

Table 2 Column 1 Column 2 Column 3 Column 4
Row A 8.0 µM Protein

5x SYPRO®
8.0 µM Protein
6.67x SYPRO®

8.0 µM Protein
10x SYPRO®

8.0 µM Protein
20x SYPRO®

Row B 4.0 µM Protein
5x SYPRO®

4.0 µM Protein
6.67x SYPRO®

4.0 µM Protein
10x SYPRO®

4.0 µM Protein
20x SYPRO®

Row C 2.0 µM Protein
5x SYPRO®

2.0 µM Protein
6.67x SYPRO®

2.0 µM Protein
10x SYPRO®

2.0 µM Protein
20x SYPRO®

Row D 1.0 µM Protein
5x SYPRO®

1.0 µM Protein
6.67x SYPRO®

1.0 µM Protein
10x SYPRO®

1.0 µM Protein
20x SYPRO®

Row E 0.5 µM Protein
5x SYPRO®

0.5 µM Protein
6.67x SYPRO®

0.5 µM Protein
10x SYPRO®

0.5 µM Protein
20x SYPRO®

	 Table 2: This table is an example of the concentration matrix for optimization.  					   
			   The actual rows and columns may be chosen by the user.

Choice of optimal Protein and Dye concentrations:

	 Note: 	 The choice of the optimal concentration is a decision made by the researcher.  The optimal 		
			   concentration differs slightly depending on the goals of the researcher.  We suggest the best curves are 	
			   those giving high fluorescence, giving a nicely shaped curve with a single peak/valley when inspected 	
			   in the LC480 Tm Calling Analysis, having a middle concentration of protein of those giving nicely 	
			   shaped, high fluorescence curves, and use the lowest SYPRO® dye concentration.  If volume is also 	
			   a factor, you may wish to assay the lowest or most appropriate volume to give the results above for 	
			   future assays.

1.		  Visual inspection of Protein Melting curves.
		  a.	 The curves should be nicely shaped with a good amount of fluorescence.  Refer to the blue and green 	
			   curves below for examples of good Protein Melting curves.

Protein Melting
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Protein Melting Experimental Conditions Setup and Determination, continued
	 b. 	 Use the Tm Calling analysis to help show the curves have a good shape.  The negative first derivative 	
			   drawing of the curves should show curves with a single valley or negative peak.  If the curve shows 	
			   multiple valleys, this is not an optimal curve.  Refer to the blue and green curves below for examples 	
			   of good Protein Melting curves.

Protein Melting Plate Setup and Run
1.		  Use the protein and dye concentrations determined from the test run above.
2.		  The Change of buffer or addition of Compound, Ligand, or interacting protein should be performed at 	
		  this time.  
3.		  A reference well (or wells) containing only the protein of interest in determined optimal conditions 		
		  without change should be maintained on plate as a reference..
4.		  Changes in Tm from the reference wells is used to determine how the changes in buffer or addition of 	
		  compounds has effected the protein stability.
5.		  Further setup is determined by the researcher.
6.		  Ligand fluorescence may effect the shape of the curve.  This was not found to effect the Tm resulting 		
		  from the test.

 

Fluorescent Decrease due 
to Ligand 

											            Protein Melting
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Protein Melting Plate Setup and Run, continued
7.		  Curves with too low of a concentration can have a poor shape, possibly giving multiple peaks in the 		
		  analysis.  Although these curves are not optimal and should have the protein concentration increased, 	
		  the Roche LightCycler® Protein Melting Analysis only generates a Tm for the greatest peak/melting 		
		  event.

8.		  The best way to ensure plate-to-plate consistency in your LightCycler® 480 plate runs for protein analysis 	
		  is to control the exposure time.  This is especially applicable if you wish to use very short melting runs, 	
		  that are less than 8 minutes run time.
		  a.	 Find run time from run used to determine the optimal protein and dye concentrations.
			    • 	 In the Experiment section, choose the Data tab.
			    • 	 Click and expand the hidden menu bar on one of the charts displayed.  See illustration below:

			    • 	 Change the Chart type to Exposure History.
			    • 	 The exposure time is displayed as Integration time (in milliseconds).  
			    • 	 Round the exposure time up to a reasonable time.  In the example above, the exposure/		
				    integration time would be rounded to 1 sec (or 1000 ms).

Protein Melting
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Protein Melting Plate Setup and Run, continued
	  	 • 	 When starting your future runs, use this exposure time by changing the exposure time to this 		
			    time. Click the Customize button, choose manual, and enter the exposure time in the Integration 	
			   Time (sec) field.  Click   to confirm the changes.  See illustration below.	

9.		  To ensure these changes are used in future analyses, a template may be created. Save the Run Program 	
		  as a Run Template by clicking the down arrow next to Apply Template, then select Save As Template.  	
10.	 Give this template an intuitive name that includes intention of the run, the detection format, and the 	
		  size of the block.  
11.	 Save the template into your desired folder to be applied to New Experiments in the future.

											            Protein Melting
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Setup of Protein Melting Analysis Tool

	 Note: 	 The Roche Protein Melting software may be obtained from a Roche Representatives or Roche 		
			   Technical Support.

1.		  Installation of the Roche Protein Melting software.
		  a.	 The CD with the Roche Protein Melting Software contains a ReadMe.doc file that describes the 		
			   installation and setup of the software.
		  b.	 Install the software by running the setup.exe file.
			      •   	 This installs the Roche Protein Melting Software and may update your computer to the 		
				    proper level Microsoft .Net Framework,  if necessary.
		  c.	 Run the LightCycler® 480 Protein Melting software.
			      •   	 The first run requires you to configure the directory watcher.  The Roche.LC480.			 
			    	 ExportWatcher watches a specific “IXO export directory” (folder) chosen by you, allowing the 	
				    Roche Protein Melting Software to immediately analyze any LightCycler® 480 .ixo file exported 	
				    into this directory.  
			      •	 Choose a CSV target directory (folder) you want to save the resulting .csv analysis file.
			      •   	 From the LightCycler® 480 Basic software, you may choose to Export a specific protein 		
				    melting .ixo run file, or Batch Export a group of these files to be analyzed.  Target this export 	
				    to the specified folder for the “IXO export directory”, set above.
		  d.	 The output of the software is a .csv file, that can be viewed in any spreadsheet or text program.  CSV 	
			   stands for comma separated value, and is a standard file format recognized by most programs. 		
			   The first line of the file is the header with the following columns:
			      •	 Program: 0-based index of the LightCycler® 480 program
			      •	 Channel: 0-based index of the LightCycler® 480 channel
			      •	 Position: 0-based position on the MWP (0…95 or 0…383)
			      •	 Call: Positive, Negative or Uncertain.
				    Negative: no results are listed in the following columns.
				    Uncertain: an additional message is listed in the Message column
			      •	 Tm: calculated melting temperature (see the Roche Protein Melting software’s ReadMe.doc for 	
				    further description)
			      •	 Slope: slope of the fluorescence signal at the Tm
			      •	 Initial: fluorescence at beginning of the curve (lowest temperature)
			      •	 Low: minimum fluorescence below Tm
			      •	 Peak: minimum fluorescence above Tm
			      •	 Message: additional calculation information, if call is uncertain.

Protein Melting
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Use of Protein Melting Analysis 
Export of LightCycler® 480 run and Protein Melting Analysis
		  Note: 	 Runs may be exported individually, in a group as a Batch Export, or exported automatically 		
				    every run with an automated or robotically controlled LightCycler® 480 setup.

Single run export 
1.		  There are two ways to perform a single run export.
		    a.	 Export from within an open run.

		    b.	 With the run of choice open, click . 
2.	Choose the appropriate export folder, chosen in the Roche LightCycler® 480 Protein Melting software.  
		    a.	 If setup properly, the Roche Protein Melting software analyzes the data instantly to produce the 		
			   analysis *.csv result file. 
3.	Export from the LC480 Navigator.
4.	Click  , or select the Navigator from the Window dropdown menu in the LightCycler® 480 software.
5.	Choose the experiment to export by left-clicking the experiment of choice.
6.	Click .  Choose the appropriate export folder, chosen in the Roche LightCycler® 480 		
	 Protein Melting software.  
	     a.	 If setup properly, the Roche Protein Melting software analyzes the data instantly to produce the 		
			   analysis *.csv result file. 

Multiple run/Batch Export
1.	Click , or select the Navigator from the Window dropdown menu in the LightCycler® 480 software

2.	Click .  Choose the appropriate export folder, chosen in the Roche LightCycler® 480 		
	 Protein Melting software.  
	     a.	 If setup properly, the Roche Protein Melting software will analyze the data instantly to produce the 	
			   analysis *.csv result files. 
3.	Automated Export
	     a.	 The automated export should be setup in your scheduling software to export the LC480 experiment 	
			   .ixo file at the end of every run. The LC480 LIMS module accommodates this.  Contact Roche 		
			   Technical Support for further information, if needed.

											            Protein Melting
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Protein Melting Analysis Result Table Description 
Roche LightCycler® 480 Protein Melting Analysis Result Table Description

1.	The output of the software is a .csv file, that can be viewed in any spreadsheet or text program.  CSV 		
	 stands for comma separated value, and is a standard file format recognized by most of these programs.

	 a.   The first line of the file is the header with the following columns:
		  •	 Program: 0-based index of the LightCycler® 480 program
	   	•	 Channel: 0-based index of the LightCycler® 480 channel
		  •	 Position: 0-based position on the MWP (0…95 or 0…383)
		  •	 Call: Positive, Negative or Uncertain.
			   Negative: no results are listed in the following columns.
			   Uncertain: an additional message is listed in the Message column
		  •	 Tm: calculated melting temperature (see the Roche Protein Melting Software’s ReadMe.doc for 		
			   further description)
		  •	 Slope: slope of the fluorescence signal at the Tm
		  •	 Initial: fluorescence at beginning of the curve (lowest temperature)
		  •	 Low: minimum fluorescence below Tm
		  •	 Peak: maximum fluorescence above Tm
		  •	 Message: additional calculation information, if call is uncertain 

2.	The data points gathered by the LightCycler® 480 Protein Melting Analysis relate to information that		
	 could be helpful to the researcher.
	    a.	 The difference between the Initial and the Low fluorescence values relates to the affinity of the dye 	
			   for the protein or ligand/compound.
	    b.	 The difference between the Low and Peak relates to the affinity of the protein hydrophobic domains 	
			   to the dye.
	    c.	 The slope (taken by our software at the Tm exactly) is relative to the Kd determined by other 		
			   software.

Protein Melting
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Protein Melting Reagents from other vendors: 

Product Name Cat. No. Pack Size/Description
SYPRO® Orange n/a (Sigma-Aldrich)

Protein Analysis Buffer n/a This is an aqueous buffer determined by the 
researcher. This buffer should be free of BSA 

and nonspecific protein stabilizers, detergents, 
and other compounds which can/will have 
impact on the protein stability/folding or 
background fluorescence of the analysis.

Consumables: 

Product Name Cat. No. Pack Size/Description
LightCycler® 480 MultiWell 
Plate 96 (White)

04 729 692 001 5 x 10 plates and sealing foils 

LightCycler® 480 MultiWell
Plate 384  (White)

04 729 749 001 5 x 10 plates and sealing foils 

LightCycler® 480 Sealing Foil 04 729 757 001 50 foils 

											            Protein Melting
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